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SELF-PUBLISHING AT ‘XPRESS CENTRE 

WINDSOR PUBLIC LIBRARY 

 

These guidelines will help you prepare the files for your book in preparation for 

printing at Windsor Public Library. 
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Self-Publishing at ‘XPress Centre Windsor 

Public Library 

 Files need to be in an electronic format to print on the Espresso Book Machine™ 

 It is best to bring your files in on a flash drive. 

 If you have a book printed already that you would like to reproduce, you will need to 

have the pages scanned into a computer file.   

 The EBM™ can bind books with a minimum of 40 pages and a maximum of 800. 

 You need to provide 1 pdf file of the cover and 1 pdf of the interior of the book. 

 We can only produce a book for you on the EBM™ that you own the copyright to, or 

have express written permission to copy in its entirety. 

 

  

Flash drives are also known as jump 

drives, thumb drives, USB keys. 

You can find them at Shoppers or Walmart 

or any electronics stores. 
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BOOK BLOCK (INTERIOR) FORMATTING GUIDELINES 

This document refers to MS Word, but the ideas are transferrable to just about any 

program you choose to use to type your book in. Open Office Writer, Pages, InDesign, 

etc. are all good programs, but Word is the program used in the Self-Pub Centre, so any 

last minute changes can be done on our computers here. Regardless of what program 

you use, your final result needs to be a PDF.  If you’re not sure how to create a PDF, 

just give us a call or email and we’ll help you with it. 

Consistency is key! 

When formatting a text, it’s important to remember that consistency is key.  Decide what 

you want your pages to look like, and then apply those settings to the whole document 

for margins, tabs, font and point size. 

NO CHEATING! 

You may be able to get the book to look on your screen the way you want it to by 

artificially inserting spaces and tabs. However, when you go to print your book, you will 

find that taking the easy way has made your end work ten times harder. 

To format properly, follow the chart 

 DO DO NOT 

To align text Use tab key for 
indentations 

Use space bar 

To center on the page Highlight the text and click 
on the centering tool 

Use space bar or tab key 

To align right or left Highlight text and use 
appropriate formatting 
tools: align left or align 
right 

Use space bar or tab key 

To create a new page Insert > Page break Use enter until you get to a 
new page 

To insert an image Use Insert > Picture > 
From File option 

Drag and drop or copy and 
paste. 
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TRIM SIZE 

The trim size is the size of your finished book. Described as width by height in inches, 

some standard sizes include 6” x 9” or 5” x 8”.  However, your book can be any trim size 

you like, as long as it is a minimum of 4.5” wide, maximum 8.25” wide and minimum 5” 

tall, maximum 10.5” tall.  Your dimensions can be any combination, as long as they are 

within the minimum/maximum range. 

You might want to decide on, and set your trim size before you get into the final stages 

of formatting, as setting the trim size will give you a more accurate feeling about how 

your words will look on the page.  However, it is also perfectly acceptable to type your 

entire document on regular letter size paper and then format the entire thing when you 

are done.  Just keep in mind that you will not have an accurate page count until the trim 

size has been set and your document formatted to it. 

 

  

We talk in inches at the Self-Publishing Center 

instead of centimeters only because the EBM™ 

uses inches.  The trim size is always set in the 

machine in inches.  You can set up your document 

in metric if you like, but be sure to let us know 

what the trim size will be in inches. 
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To set your trim size, in MS Word, look under Page Setup or Page Layout, and choose 

paper size. Change from the default paper size to whatever you have chosen.  You will 

likely have to create a custom paper size, since your trim size probably won’t be one of 

the preset options. 

Once you have chosen your paper size, be sure to select “Apply to Whole Document.” 
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When deciding on a trim size, keep in mind that the appropriate trim size for your book 

depends on the number of pages and your spine width.  If you are considering a larger 

book, keep in mind that the greater the number of pages, the wider your spine.  If you 

have a wide spine coupled with the maximum trim size (8.25” x 10.5”), you run the risk 

of falling short on coverage.  If your book is longer than 300 pages, the maximum trim 

size you can have will be affected.   

 

Also keep in mind that the smaller your trim size, the greater the number of pages you 

will have in your book (because there is less “page” space to print on).  This will affect 

your cost, since we charge a per page fee.  You can always play around with your 

document by trying out different page sizes to see how much your page count goes up 

or down. 

MARGINS 

Margins are the space between your text and the edge of your printed page. 

The EBM™ requires a minimum of .8” margin all around, but you can go bigger if you 

prefer.   

In MS Word, under Page Setup or Page Layout, you can set the margins to your liking.  

You can also set up mirror margins so that the interior margins of each page are slightly 

bigger than the exterior margins.  This will provide a “gutter” between the edge of the 

text and spine, ensuring that your text is not too close to the spine once the book is 

bound.   
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Margins in MS Word 

 

TABS AND LINE SPACING 

Standard tabs are between .25” and .5”.  It’s a good idea to choose your preferred tab 

size and apply that setting to your whole document.  That way any tabs used throughout 

will be the same size and the document layout will be visually consistent. 
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Single spacing is discouraged, as it is often difficult to read.  Double spacing is wider 

than necessary and will add on to your page count.  Therefore, 1.15 or 1.25 spacing is 

suggested. 

In MS Word, you can modify your Tabs settings and Line Spacing under Paragraph. 

FONTS: STYLES AND SIZES 

Studies have shown that serif fonts are easier to read and there is better 

comprehension of material than that which is typed in sans serif.  Serif fonts are those 

with “feet” – generally some extra mark or flourish at the bottom of the letter, as 

opposed to Arial (the font used in this document), where the letters go straight down to 

the bottom of the line. 

Here are some examples of serif fonts: 

Times New Roman Garamond  Palatino  Century 

Here are some examples of sans serif fonts: 

Tahoma  Arial  Lucida Sans  Verdana 

Standard font size is between 10 and 12 pt. type.  Keep in mind your audience, though.  

Older audiences, ESL readers and children often prefer a larger font for ease of 

reading. 

You can use different fonts for your chapter titles and section headings which 

complement your body text.  You could even use sans serif fonts, or the same font as 

your body text, if you bold the text or increase the size to make it stand out. 

FRONT, CORE AND BACK MATTER 

Your book will not have the exact same formatting throughout.  This is because some 

pages like your title page, copyright page, about the author, and bibliography pages 

should not have page numbers.  MS Word is difficult to manipulate in regards to getting 

page numbers on some pages in your document, but not on others. For this reason, we 

recommend actually creating separate documents of those sections that should have 

page numbers, and those that shouldn’t. These sections are the Front, Core and Back 

matter of your book. 
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Front Matter Core Matter Back Matter 

 Anything leading 
up to the first page 
of your text  

 Title page, 
copyright page, 
acknowledgments, 
dedication, 
foreword, preface, 
introduction, table 
of contents and any 
blank pages 

 Your core text, the 
guts of your book, 
where page one of 
your book actually 
begins 

 Anything after your 
text ends. 

 Afterword, about the 
author, bibliography, 
index, glossary, etc. 

NO PAGE NUMBERS PAGE NUMBERS NO PAGE NUMBERS 

   

 

When you insert page numbers on your core matter document, you can start at page 

one or set your first page number to start on whatever number will incorporate the non-

numbered pages in your front matter. 

Consider whether you want your page numbers at the top or bottom of the page, 

centered or aligned to the outside of your page.  Choose a font that complements your 

body text.  Try using the same point size, or 2 points smaller – whatever looks best to 

you. 

When you’re reading to create the final PDF, convert each of these three documents to 

PDF separately, and then combine them.  If you have trouble merging PDFs we have 

the tools to do so easily in the ‘XPress Centre. 

HEADERS/FOOTERS 

Decide if you want any headers or footers on your text pages.  Some books have the 

book title, chapter title or author name at the top or bottom of each page.  Keep in mind 

that you can choose to insert them on odd or even pages only.  In MS Word, use Insert 

> Header (or Footer or Page Number) to add your text. 

Header and footer text appears in the space between your body text and the edge of 

the page.  For example, if you set up a .8” margin, then the header/footer will appear 

within that .8” margin.  Be sure that the header/footer text is still at least .25” from the 

edge of the page.  Adding headers or footers that are too close to the body text can 
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make the page look crowded, so refer to other books for examples and use your own 

judgment.  When you align your headers and footers, be sure to avoid aligning them to 

the inside margins, as they will get lost in the spine. Centering them is easiest.  

CHAPTERS/SECTIONS 

When you want to start a chapter or section on a new page, remember to use the Insert 

> Page break function rather than hitting the enter key until you scroll to the next page. 

There are several possibilities for making your chapter or section headings stand out: 

 Point size, or bolding can be used to set it apart 

 Placement of the heading can be centered or further down the page from the top 

 Some authors choose to start the first paragraph at the top of the page, and 

others like to drop it 1/3 of the way down. 

 Sometimes the first few words or first line of the paragraph are indented, 

capitalized, in drop caps or bolded to make them stand out. 

 The first chapter or section of any book usually shows up on the right-hand side 

of the book. 
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  Chapter number 

Garamond, 10 pt, 

All Caps 

Chapter title 

Garamond, 20, 

Bold 

Page number, 

Centered, 

Bottom 

Starts 1/3 down 

the page 

Drop capital 
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This shows what two book pages look like side by side when holding an open book.  

Even pages fall on the left and odd pages fall on the right. 

NOTE: This refers to the page number in the whole document, not the page 

number you have assigned it. 

For example, in your Word document, you can see your page count at the bottom 

left of the screen.  It will say, for instance, Page: 97 of 160.  Since 97 is an odd 

number, you know that the page you are looking at will fall on the right hand side 

of the book. 

Headers are centered at the top, alternating book title and chapter title. All text is 

justified (aligned to both left and right margins). 

Page size is 6” x 9”. 

Line spacing is 1.15.  

Margins are .8” all around. 

Tabs are .25” 

  

Chapter Title 

Book Title 
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OTHER BOOK BASICS 

Regardless of your book’s subject matter, all books should begin with a title page.  The 

title page should contain the book title and author, and can also list the subtitle and 

publisher.  The next page in your PDF should be the copyright page, so that title page 

and copyright page print on the front and back of the same sheet of paper. 

NOTE: In Canada, is not necessary to use the copyright symbol (©).  You are 

protected just by writing Copyright, Name, Date.  However, it is easy to insert, 

and if you are looking at an international market, it is a good idea to include it. 

Some authors like to have a blank sheet of paper at the beginning of the book, right 

before the title page. If you plan to have this, remember that a blank sheet of paper 

equals TWO blank pages in your Word document.  The title page should fall on the 

right-hand side of the book, so should be an odd page in your document. 

Whether your book includes this blank page, or any dedications, table of contents etc., 

is entirely up to you.  Browse some existing books – particularly those that are similar to 

yours in subject or audience – to get a sense of standard formatting practices. 
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CREATING A PDF 

Creating a PDF is relatively simple.  In some software programs, like most versions of 

Word, you can use the File > Save As option, where you save your final file as a PDF 

instead of a .doc file. 

NOTE: When creating the PDF, the setting for PDF/X -1a:2001 is ideal, 

especially if your file has embedded fonts. 
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If your software does not have “save as PDF,” you can try the option “Print to” PDF.  

Make sure that the PDF you “print” retains the same page size as your original. 

 

Some programs will also have an Export option that allows you to generate a PDF. 

If your software does not allow you to general a PDF, you may need to download a PDF 

conversion tool from the internet, like www.cutepdf.com.  

  

http://www.cutepdf.com/
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IMAGES 

You must own the rights to, or have permission to use, any images that you include in 

your book. 

When scanning images, the scan should be set to at least 300 DPI.  While TIFF files are 

recommended by the distributors of the EBM™, jpgs work just as well. 

BOOK COVER (EXTERIOR) FORMATTING GUIDELINES 
BASICS 

The cover can be in color (it will print on a full-color inkjet). 

Nothing can print on the interior side of the front or back cover. 

Covers can be designed in a variety of software, including MS Word, Adobe InDesign or 

Photoshop. 

For layout purposes, your cover is the back + spine + front of your book, laid out as a 

single landscape-oriented image.  It will be printed on a 17: x 11” sheet of cover stock, 

no matter what size book you end up with.  The cover wraps around the book block 

(interior) and they are trimmed together. 

Make sure you have a ¼” to ½” bleed on all sides. 

 
17” wide 

11” tall 
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Before Designing Your Cover 

Before you begin to design your cover, you must know your spine width.  This is 

important because it will affect the layout of your front and back covers.  If you don’t 

allow enough space for your spine, images that should be on the front and back will end 

up on the spine, and if you allow too much space, your spine will wrap around to the 

front and back of the book. 

Xerox recommends using a formula for calculating your spine.  The formula is: 

 

Page count ÷ PPI (pages per inch) of the paper you’re using = spine width in inches 

A 200 page book printed at Windsor Public Library would have a spine width of: 

200 (pages in your document) ÷ 444 (PPI value for our white paper) 

= .45” 

NOTE:  

This is always an approximate value, as many factors, including humidity, can 

affect the pages per inch number. 

 

Detailed instructions on creating a cover can be found in the document titled Creating a 

Book Cover for the Espresso Book Machine™.  The instructions are for using 

Photoshop, but the principles can be transferred to whichever program you choose to 

use.  Photoshop is available on the computers in the ‘XPress Self-Publishing Centre at 

the library, and staff is on hand to assist. 

 

 

 


